Canon

Picture Style File Creating Software

Picture Style Editor

Ver. 1.4

Instruction Manual

Content of this Instruction Manual

PSE is used for Picture Style Editor.

In this manual, the windows used in the
examples are from Windows XP.

» indicates the selection procedure of the menu.

(Example: [File] menu » [EXxit].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.

(O : next page
€D : previous page
: return to a page you had previously
displayed
Click on the headings on the right side of the
screen to switch to the contents page of that
heading. Also, click the item you want to read

about on the table of contents to move to the
relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction System Requirements

Introduction

Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit Windows Vista*L
Picture Style to your unique image characteristics and save the edited oS Windows XP Professional/Home Edition*2
results as original Picture Style files. PC with one of the above OS preinstalled (Upgraded Contents
. . . Computer | machines not supported)
What is a Picture Style file? * NET Framework 2.0 or later is required.*3
A Picture Style file (extension “.PF2”) is an extended function of a CPU 1.3GHz Pentium or higher
Picture Style. It differs from the 6 preset Picture Styles (Standard, - Preparing
Portr_ait, ITandscape, Neut_ra!, Faithful and Mo_noc_hrome) ar_md' RAM I\S/Itlzrr“erzsr:]eijiion' 1024 = 768 pixels or more a Sample
provides image characteristics that are effective in a very limited Display Color quality: Medium (16 bit) or more
number of scenes. _
You can further expand your photographic expression by using a *1 Compatible with 32-bit/64-bit systems for all versions except Starter WiBI’ladSCI)SVS
Picture Style file effective for a specific scene. Edition (Also compatible with Service Pack 1)
) *2 Compatible with Service Pack 2/Service Pack 3
Main Features of PSE *3 .NET Framework is Microsoft software. It is installed together with
With PSE, you can use the functions below to edit Picture Style to PSE. Pre-adjustments
your unique image characteristics and save the edited results as
original Picture Style files (extension “.PF2").
Select a Picture Style to be used as a basis for your images : Image
Set the [Sharpness], [Contrast], [Color saturation] and [Color tone] Sam p | € Im ag esS fO r Adj ustment CharaCtgriStiCS
Make minute adjustments to a specific color PSE enables you to use RAW images shot with EOS DIGITAL cameras*
Adjust the brightness and contrast (gamma characteristic) (excluding the EOS DCS1 and EOS DCS3) as sample images for
In addition, you can register your saved original Picture Style files on adjustment. You can then save the completed adjustments as original Saving
a camera with the Picture Style function and then apply those styles Picture Style files.
to shot images. You can also use Digital Photo Professional to apply * Compatible with RAW images shot with EOS D6000 or EOS D2000
the styles to RAW images. that have been converted to RAW images using the CR2 Converter ot
and have the “.CR2" extension. reterences
Color man agem ent For information on CR2 Converter, refer to Canon’s web site.
Use PSE in a computer environment with color management.
Also, set the profile of the monitor you are using and the color space
of the sample image to be used to perform the adjustments, etc. in Reference
the preferences window (p.16).
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Preparing Sample Images

PSE uses a sample image to perform the various adjustments and save
the adjusted results as an original Picture Style file. For this reason, a
sample image (p.2) to be used for this purpose needs to be prepared in
advance and saved on your computer.

The settings performed in PSE are saved as a Picture Style file (p.15)
which is separate from the sample image, and the sample image used
to perform the adjustments itself is not affected at all.

Starting up PSE

Double-click the [Picture Style Editor] icon on the
desktop.
The main window (Description on the right) appears when PSE
starts up.

|§| You can also start up PSE from the camera software “EOS Utility”.
Refer to the “Function for Use with the Accessories” of “Reference”
in “EOS Utility Instruction Manual” (PDF electronic manual) for
details.

Opening a Sample Image
Open a sample image and perform various adjustments with that image
as a basis.

Drag and drop a sample image to the main window.

Drag and drop

=» The sample image is displayed in the main window with the
camera settings at the time of shooting.
=» The [Tool palette] appears.

|§| If you adjust a RAW image in Digital Photo Professional
(hereinafter, “DPP”") and then open it as a sample image with
PSE, the adjustments made in DPP will not appear in the image.
If you open a RAW image, which has had the Auto Lighting
Optimizer settings set in the camera or DPP, as a sample image
with PSE, the Auto Lighting Optimizer settings set in the camera
or DPP will not appear in the image.
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Basic Windows

Main Window

You can select the display magnification and the display method, etc. of the sample image.

Image rotation
(90 degree units to
the left or right)

Before and after
adjustment
comparison display
(Top/bottom split)
(p.6)

Before and after
adjustment
comparison display
(Left/right split) (p.6)

Normal screen

Cursor coordinates
position

[:Z Picture Style Editor - [ C:\Documents and Settings\Desktop\_MG_0001.CR2 ]
File  Edit ¥iew Toaols Help

100% (actual pixel size)
view

Full view

Display magnification
(5 ratios: 12.5%, 25%,
50%, 100% and 200%)

= 0=

X:2201 Y1070 HSL: [215, 48, 55] = [215, 48,55] ( 0, 0, 0) Work color space sRGB

Work color space display (p.16)

Color values of the cursor position (Before adjustment/after adjustment/
difference between before and after adjustment) (8-bit conversion)

Color display mode (p.8, p.14)

)

Introduction

Contents

Preparing
a Sample

Basic

Windows

Pre-adjustments

Image
Characteristics

Saving

-

Preferences

Reference

00
©




)

Introduction
Enlarging a Specific Area Adjusting While Comparing with the Original Image
You can enlarge a specific area in the main window to 100%. You can display before and after versions of an adjusted image in the
same window and perform adjustments while checking the adjustment
. . . Contents
In the main window, double-click the area you want results.
to enlarge.
Select [[&]] or [[@)]. _
-:'Z:lu“iil-::ll)(umrnn and Settings\Desktopl_MG_0001.CR2 | P rep arl n g
- a Sample

= @ &=

Basic

Windows

Double-click —
2382 ¥ 602 HSL [213, 5, 78] >[213, 5,781 ( 0, 0, @

Pre-adjustments
» The image is displayed split top and bottom or left and right.

[[E]] (Top/bottom splity display  [[EL]] (Left/right split) displa Charmage .

Rl =] - .,._—. _. T ———— Y TEE ._-.. .-.....‘.“....,-.‘...-....,...._- | CEE L )
The area you double-clicked is enlarged to 100% (actual pixel Saving
size). If you wait for a while, it changes to a clearer display.
To change the display position, drag on the image or drag the .
enlargemgnt dlsplay position (p.7) in thfe [Navigator] window. Preferences
Double-click again to revert to the full view.

The image is displayed The image is displayed o

before adjustment at the top, before adjustment on the left, eterence

and after adjustment at the and after adjustment on the

bottom. right.

00
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Navigator Window

In the main window, the display position of an image when it is enlarged
and the image histogram are displayed. You can also set warning
indicators to prevent excessive settings being made.

Displaying the [Navigator] window.
Select the [View] menu » [Navigator].

Mawigator

Enlargement display position

(p.6)
Move the display position by
dragging

ol RGB ] R | G | B ] Switches the histogram display

Histogram

Warning indicator setting

1ing on images

& —— Warning range

|§| [Y] in the histogram display indicates luminance.

Setting the Warning Indicators

You can set warning indicators for luminance values (Y) and color
values (RGB) which are useful for preventing excessive settings being
made. Luminance and color value domains which are outside the set
range blink as warning indicators on images in the main window.

Checkmark [Show warning on images] and select [Y]
or [RGB].

__ )

=

Enter the upper and lower limit values of the warning

“*~ range.

=» The domain where values are outside the upper and lower limit of
the range blinks on the image in the main window.

@ To stop the warning indicators, remove the check mark from the
[Show warning on images] checkbox.

)
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Tool Palette

You can adjust the image characteristics of the Picture Style file by using
the various functions of the [Tool palette].

Because the adjustments made with the [Tool palette] are immediately
applied to the image in the main window, you can check the results as
you work.

Select a Picture Style to be used as a basis (p.9)

Sharpness, Contrast, Color saturation,
Color tone settings (p.10)

Load a Picture Style file (p.10)

Tool palette

Save a Picture Style file (p.15)

Minute adjustments to
a specified color (p.11)

Adjustment color list (p.13)

|
Input | ‘

Output

s Color display mode (p.14)

Adjust the brightness and contrast (gamma characteristic) (p.14)

|§| You can select the [View] menu P [Tool palette] to alternate the [Tool
palette] show/hide.

Pre-adjusting the Images

Sample images used in the adjustment process (p.2) which do not have
proper exposure or white balance can be adjusted using the
[Preliminary adjustment] window to correct their brightness and white
balance.

However, please remember that adjustments made with the [Preliminary
adjustment] window are merely pre-adjustments for correcting
adjustments made with the [Tool palette] (Description on the left). For
this reason, adjustments made with the [Preliminary adjustment] window
are not saved in the Picture Style file which you create.

If the sample image used for making the adjustments has proper
exposure and white balance, you do not have to make adjustments with
the [Preliminary adjustment] window.

Correcting the Brightness

# Select the [Tools] menu P [Preliminary adjustment].
=» The [Preliminary adjustment] window appears.
When the [Preliminary adjustment] window appears, the display
switches to normal display, even if the main window display is
showing a comparison of an image before and after adjustment

(p-6).
") Adjust to correct the brightness of the image.

> |
Preliminary adjustment

Brightness adjustment Reset

: Drag to the left or right
; [0.00 .
: : —— to adjust
White balance adjustment

| —TE—
Reset |

Shot seftings V| # ]

close

The adjustments are applied to the image.

)
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Correcting the White Balance
Adjust to correct the white balance.

Preliminary adjusiment

Brightness adjustment

White balance adjustment

Click white balance

Click the [ ] button
and then click on a point

that is to be the standard

for white

The color temperature slider
Select [Color temperature] from the white balance
list box, and then drag the slider left or right

Select the white balance

The adjustments are applied to the image.

Setting the Image Characteristics

You can adjust the image characteristics by using the various functions
of the [Tool palette].

All the adjustments made with the functions in the [Tool palette] become
the image characteristics of the Picture Style file.

Selecting a Picture Style to Be Used as a Basis

Select the Picture Style to become the basis of the adjustments from the
5 preset (except Monochrome) Picture Styles (Standard, Portrait,
Landscape, Neutral and Faithful).

You can also register and use a Picture Style file effective for the scene
that you have downloaded from Canon’s web site.

)

Introduction

Contents

Preparing
a Sample

Basic
Windows

Select a Picture Style.
Tool palette g|

Base Pictura Style

EEE RIS 5

M Show affected area on images

=» The selected Picture Style is applied to the image.

Pre-adjustments

Image

Characteristics

Saving

Preferences

Reference




Using a Downloaded Picture Style File
Effective for the Scene
Click the [[&']] button.

The [Open Picture Style file] window appeatrs.

Select a Picture Style file to be registered and click
the [Open] button.
The selected Picture Style file is applied to the image.

|§| Original Picture Style files created with PSE (p.15) can also be
registered and used by following the procedure above.
Picture Style files compatible with PSE are files with the “.PF2”
extension.

Setting Sharpness, Contrast, Color Saturation and Color Tone
Click the [Advanced] button.
Tool palette E|

Base Pictura Style

V[ havnces Y |

B Show affected area on images

The [Advanced Picture Style settings] window appears.
Drag each slider and then click the [OK] button.

Advanced Picture Style settings @

O A 4 5 SE B 9 10

Sharpness i 773
=4 <3 2 -1 0f+1 +2 +3 +4

Contrast: A j

Drag the sliders left or
= 3 P -1 0J+1 +2 +3 +4 .
- right

Color saturation: - j

4 3 -1 0 f+1 +2 +3 44

Color tone: 5
—

The settings are applied to the image.
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_ Introduction
Determine the range of effect for the color you want

Making Minute Adjustments to Color _
to adjust.

You can make minute adjustments to a color you have specified, using
the hue, saturation and luminosity functions in order to get the color you
want. You can also set a range for the effect on surrounding colors Color of the adjustment point selected in step 1
which occurs when you adjust the colors you have specified.

Within the frame is the range of effect Contents

Preparing
Specify the color you want to adjust. a Sample
Click the [ ] button and then click the color you want to
adjust on the image.
Basic
Tool paletie [z| Windows
Range of
Base Picture Style upper and
L Advanced | & | i | lower limit of Pre-adjustments
B Show affected area on images Iuminosity
2 Click Drag to
move up or image
down

Characteristics

iDocuments and Settings\canon\Desktopl_MG_0001.C S _
Luminosity level of the adjustment

point selected in step 1 Saving
Range of upper and lower limit of saturation  —
Drag to move towards the center or towards CE——
the outer perimeter Preferences
Range of upper and lower limit of hue
Drag to move towards the perimeter of the circle
The range of effect for hue, saturation and luminosity can be set Reference
within the limits below.
- . . Settin Range
The selected color is displayed as an adjustment point and as g g @ @
[(3] on the color wheel. Hue 30 - 180 degrees

Saturation 30 - 100 @

Luminosity 30 - 100

11



Adjust the color.

Drag to the left or right to adjust

The color is adjusted to the range specified in step 2 and the
color of the image changes.

When dragging the slider, the point before adjustment [((1] and
the point after adjustment [ ] will be displayed on the color
wheel.

Check the range of application.
If you checkmark [Show affected area on images], the range of
application of the adjusted color blinks on the image.

Tool palette FZ|

Base Picture Style

R ST £ D

B Show affected area on images

4
A

Repeat steps 1 to 4 to adjust multiple colors.
You can select and adjust colors for up to a maximum of 100
spots.

|§| You can also specify the color to be adjusted in the different method

from the one explained in step 1 (p.13).

)

Introduction

Contents

Preparing
a Sample

Basic
Windows

Pre-adjustments

Image
Characteristics

Preferences

Reference

00
©

12




Specifying the Color Directly

In addition to specifying the adjustment point by clicking the color on the
image (p.11), you can also specify the color directly on the color wheel
or by entering the color value.

Specifying the Color on the Color Wheel
Click the [ ] button (p.12).

Click the color you want to adjust on the color wheel.

The selected color is displayed as an adjustment point [{(1] on
the color wheel.

Specifying the Color by Entering the Color
Value

Select the [Edit] menu P [Specify the numerical
values for color adjustment].
The [Specify the numerical values for color adjustment] window
appears.

Enter the color value.
The entered color value is displayed on the color wheel as an
adjustment point [ (1] on the color wheel.

Displaying the Adjustment Color List and its Functions

In addition to displaying colors before and after adjustment, the
adjustment color list (p.8) shows any overlapping of the range of effect
of adjusted colors, and has a checkbox for applying adjusted colors and
preventing adjusted colors from being applied.

— P p— Color before adjustment

Color after adjustment

~— A

Displays any overlapping in the range of effect of adjusted colors
Remove the checkmark to prevent the adjusted colors from being applied

Overlapping with the Range of Effect of
Adjusted Colors

When you select an adjusted color from the list and [11}] appears, the
range of effect (p.11) of the adjusted color is overlapping with the range
of effect of other adjusted colors. Moreover, the overlapping areas will
be displayed in gray on the color wheel and the color is applied by
aggregating adjustment results.

To avoid an overlapping of the ranges of effect, select the subject color
which has a [(1}] and reset it so that the range of effect of the hue and
saturation no longer overlap.

Deleting an Adjusted Color

Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to

delete and then press the <Del> key on the keyboard.

The selected adjusted color is deleted.
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Color Display Mode

You can select the color display mode which will be the basis for color
adjustment from three options (HSL, Lab or RGB) as well as check
values for adjusted colors.

Switches the color display
mode

Color value after adjustment
Color value before adjustment

When “HSL" is selected for the color display mode, you can only
change the color value for before adjustment by entering a
number.

|§| HSL is a color mode expressed by the three elements of hue (H),
saturation (S) and luminosity (L).
Lab is a color mode developed by the CIE (Commission
Internationale d’Eclairage) where L displays lightness, a displays
color elements from green to magenta and b displays color
elements from blue to yellow.
RGB is a color mode which expresses red (R), green (G) and
blue (B), the three primary colors (additive colors) of the visible
light spectrum.

Adjusting Brightness and Contrast (Gamma Characteristic)

You can adjust the brightness and contrast of a specific area using the
tone curve.

Adjust the brightness and contrast.

Click to add a [[]
(adjustment point) and
adjust by dragging

The setting value of the
selected point (you can
also enter numerical
values)
=» The brightness and contrast of the image change.
©® The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[O] is 10.
To delete a [[], select the [[]] and then either press the <Del>
key on the keyboard or double-click on the [[J].

 ——
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Saving the Adjustments as a Picture Style File

Adjustments specified in the [Tool palette] (p.9 to p.14) are saved on
your computer as an original Picture Style file (extension “.PF2").

The adjustments are saved as a Picture Style file which is separate from
the sample image, and the sample image used to perform the
adjustments itself is not affected at all.

Click the [(&]] button.

The [Save Picture Style file] window appears.

Specify the file name and save destination and then
click the [Save] button.

If you do not want to show the settings adjusted in PSE,
checkmark [Disable subsequent editing] and save, so that the file
cannot be opened again in PSE.

Save Picture Style file @gj
Savein: | (@ Desktop v o (-
5 [3My Documents
£ 4 My Computer
MyRecent | “4My Network Places
Documer ts
?-gi
Desktop
My Document s
i!)g
Wy Computer
‘:} Saveaslype:  PF2[pl2) v
.
My Network,
Caption
Copyright
[] Dizable subsequent editing

The file is saved as a Picture Style file in the specified save
destination.

|§| Even if you checkmark [Disable subsequent editing] and save, you
can use the Picture Style file the same way as the Picture Style file
without chekmarking and saved (Description on the right). However,
you will no longer be able to open the Picture Style file in PSE. For
this reason, we recommend that you save separately beforehand
the Picture Style file without checkmarking [Disable subsequent
editing].

Using a Picture Style File

Saved Picture Style files can be registered in the camera and applied to
shot images. They can also be applied to RAW images using Digital
Photo Professional (hereinafter, “DPP”).

Registering a Picture Style File to the Camera

Picture Style files saved on your computer can be registered to the
“Camera that has a Picture Style function settings” (For information on
whether your camera is equipped with the Picture Style function, refer to
the camera’s Instruction Manual.) using EOS Utility and applied to shot
images.

Refer to “Applying Picture Style Files to the Camera” of “Chapter 2
Setting the Camera from Your Computer” in “EOS Utility Instruction
Manual” (PDF electronic manual) for details on operation.

Using a Picture Style File with DPP

Picture Style files saved on your computer can be applied to RAW
images using DPP.

Refer to “Using a Picture Style File” of “Chapter 3 Advanced Image
Editing and Printing” in “Digital Photo Professional Instruction Manual”
(PDF electronic manual) for details on operation.
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Preferences

You can perform color management settings such as specifying the
work color space for the sample image displayed in the main window, or
setting the profile for the monitor.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Specify the required settings and then click the [OK]
button.

Default settings of WWork color space
® sRGB
O AdoheRGB

Color Management Setting
) sRGH
) Monitor Profile

Browse...

The settings are applied.

|§| If you have changed the work color space during the adjustment
process, the adjustment point on the color wheel sometimes moves
in conjunction with the selected work color space.

Exiting PSE

In the main window, select the [File] menu P [EXit].
PSE exits.
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Reference
Troubleshooting

If PSE is not operating correctly, refer to the items below.

Installation could not be completed correctly

You cannot install the software if a user setting other than [Computer
administrator] privilege or [Administrator] privilege is selected. Select
the [Computer administrator] privilege user setting in Windows XP or
the [Administrator] privilege user setting in Windows Vista. For
detailed information on selecting the user setting, refer to your
computer User’s Manual.

PSE does not work

PSE does not operate correctly on a computer if its system
requirements does not meet. Use PSE on a computer with compatible
system requirements (p.2).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.2), if other applications are running at the
same time as PSE, you may not have sufficient RAM (memory). Exit
any applications other than PSE.

Images do not display properly

Sample images that are not supported by PSE (p.2) do not display.

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under the Computer administrator/Administrator privileges
when uninstalling the software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [Start] button (@] button in Windows
Vista) » [All Programs] P [Canon Utilities] » [Picture
Style Editor] P [Picture Style Editor Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments
Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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